
Hutchinson Multimedia Encyclopedia README file
Release 1.21

This README file contains information about "Hutchinson Multimedia Encyclopedia" 
that was unavailable when the Manual was printed and information that may be of help
in solving some commonly found problems.

To read this file on-screen, use the Page Down and Page Up keys on your keyboard. 
You can also print the file by choosing the Print command from the File menu in any 
Windows word-processing program.

Encyclopedia Manual

The Manual is presented as a Winhelp file. Once you've installed "Hutchinson 
Multimedia Encyclopedia", you can access help by Pressing <F1>. There's also audio 
help which will be explained automatically the first time you run "Hutchinson 
Multimedia Encyclopedia".

Encyclopedia Installation

To install "Hutchinson Multimedia Encyclopedia", run Setup.exe from D:\ where D: is 
the drive letter of your CD-ROM.

"Hutchinson Multimedia Encyclopedia" can be installed on a network for workstations 
to access without having to have the software installed on their hard disk (3 to 11MB). 
To do this, the Network administratior should install "Hutchinson Multimedia 
Encyclopedia" from the CD-ROM onto a network drive (say P:). This must be done by 
running SETUP.EXE /A.

Workstations can then install a configuration file and a program icon onto their 
machine by running P:\HME\SETUP /N. The CD-ROM drive requested is the drive 
letter that will be used (over the network).

Obviously, you'll get the best performance if you install "Hutchinson Multimedia 
Encyclopedia" on a hard disk with its own CD-ROM.

Atlas Installation

During installation, you will be prompted to copy the Atlas files onto hard disk to 
improve performance. This will occupy about 8MB, so don't do it if you can't afford the 
disk space. The performance improvement however, is very significant.

If you decide to delete the files at a later date (from C:\HME\ATLAS), you'll need to re-
install "Hutchinson Multimedia Encyclopedia".

Bitmap Installation

During installation, you will be prompted to copy the Bitmap files onto hard disk to 
improve performance. This will occupy about 9MB, so don't do it if you can't afford the 
disk space. Machines with 486DX processors, more than 4MB of RAM will probably 
not need to choose this option.
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If you decide to delete the files at a later date, you only need to delete all .DIB files 
from C:\HME (the software will then automatically take them from the CD-ROM.

INDEO 3.22 Installation

The Installation of the new Indeo 3.22 video drivers has been integrated into the 
installation of the application. When the Encyclopedia runs, the drivers will 
automatically be installed if you've not already got them installed.

ERRATA - The Atlas

The Atlas Audio help describing how to zoom in and out is incorrect. To zoom in, 
double click with your left mouse button. To zoom out, double click with your right 
mouse button.

If you double click with your left mouse button on a place name in yellow or white, you 
will be taken to the display screen giving you the encyclopedia information about that 
place. You can use the step back button to get back to the Atlas directly from the 
display screen.

If you can't read some text on the map, try moving your mouse over it; the name 
should then appear at the top right of the screen.

ERROR - "This application will not run at this screen resolution"

1024x768 resolution may only be used if "Small fonts" are selected.

OTHER INSTALLATION ERRORS

If you encounter other errors during installation, the simplest advice that often works is 
to exit Windows and then re-run Windows and immediately run the installation by 
running SETUP.EXE.

If installation fails when you're actually re-installing the encyclopedia on the machine, 
you may need to delete phonfont.* from the Windows\system directory.

ERROR - Memory Overflow while Printing Pictures

If you encounter this error when printing pictures, you could try reducing the printer 
resolution using Control Panel. If you're using a laser printer configured at 600 dots per
inch, it may take more memory than you've got available to print the picture full size on
your paper. Try reducing the resolution to 300 dpi.

You may also have to reduce to 300dpi if your pictures don't print as you would expect.

RUNNING ON A MACHINE WITH LESS THAN 8MB

While every effort has been made to ensure that this product will run on a low 
specification MPC machine, you may still experience problems if the machine has not 
been configured correctly.

To get the maximum available memory on your machine, we recommend the 
following...
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1) Run windows with "WIN/3"
2) Configure the largest "Swap file" you can.
3) Use a permanent "Swap file" for increased speed.
4) Don't run any other applications at the same time.
5) Run at 640x480 (256 colours) screen resolution.

"Hutchinson Multimedia Encyclopedia" does its best to run on this configuration, but it 
will inevitably be slower than a machine with 4MB or more.

Additional Help for users of 4MB systems

On certain 4 MB systems, users may experience difficulty in displaying images. This may 
be accompanied by an error which reports that "HME95 caused a General Protection Fault
in module DECO.DLL at 0006:1DCD" or similar. This problem may be cured by increasing 
the size of the Windows Swap file which provides virtual memory for Windows to use. The
way in which this is done is described below.

1. The Windows swap file is a file held on the hard disc of the PC. Windows 
calculates the maximum permissible size of the file by looking at the free 
space available on the hard disc and doing some calculations. To maximise 
the performance of the Windows swap file, you want to have as much space 
available on the hard disc as possible. NOTE: you should not create a swap file
on a compressed drive (a compressed drive is one which is created by utilities
such as DoubleSpace, Stacker etc).

You should therefore think carefully about removing any software which you 
do not require. Having made as much space available as you safely can, you 
may have a hard disk defragmenting program which is used to pack all the 
free disk space into one block. Examples of such software are DEFRAG, 
provided with MS-DOS 6, and Norton Utilities SPEEDISK. For instructions on 
how these work, refer to the original documentation provided with the 
product.

2. You have now optimised the free space on your system. Configure your 
Windows swap file by starting up Windows, and running the Control Panel, 
which is found in the Main group.  This will display a box containing a number 
of icons or applets. Double click on the "386 Enhanced" applet. This will open 
up another box, in which there is a button marked "Virtual Memory". Click on 
this, and the Windows swap file configuration information will appear. 

You may select both the type and size of swap file. Select Permanent as the 
type of swap file, and look at the recommended size figure the system 
suggests. This needs to be above 6MB for the fix to be successful. 

If the size recommended is less than 6MB, select Cancel in each box until you 
are back in the Control Panel. From there select the File menu, and select Exit 
from there to return to the Program Manager. You should then contact 
ATTICA's Technical Support desk.  

If the swap file size is above 6MB, select OK. This will create (or alter) your 
swap file to the size specified. You will be prompted to restart Windows - 
select the Restart Windows button to implement the changes made.

You may then restart the Hutchinson Multimedia Encyclopedia '95, and the 
system should now display images correctly.
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TRUE COLOUR IMAGES

"Hutchinson Multimedia Encyclopedia" includes "True Colour" images which means 
that on systems that support them, up to 16 Milion colours can be displayed. These 
images are stored with Fractal Compression technology (supplied by Iterated Systems
Inc). They will make best use of your display adaptor, so on systems displaying 32K or
64K colours, the pictures will look much better than in 256 colour modes.

IMPROVING PERFORMANCE

HOW TO MAKE "Hutchinson Multimedia Encyclopedia" RUN FASTER

"Hutchinson Multimedia Encyclopedia" uses your computer's memory (RAM) to display
pictures and play music.  If it runs slowly or you see out-of-memory errors, "Hutchinson
Multimedia Encyclopedia" may not have enough memory.  Below are some ideas to 
make "Hutchinson Multimedia Encyclopedia" run faster.

* Close all applications you aren't using.

* Set up a permanent Windows swap file.  If you are running Windows in 
386 Enhanced Mode (look in the Help About menu of Program Manager if
you are not sure), set up a permanent Windows swap file on your hard 
disk.  To set up a permanent Windows swap file on your hard disk, open 
Windows Control Panel (usually in the "Main" program group of Program 
Manager), and click on the icon "386 Enhanced".  Then use the "Virtual 
Memory" button to see whether your current swap file is temporary or 
permanent, to check the size of the current swap file, and to make 
changes.   Windows usually creates a temporary swap file by default, but 
if your disk is full or fragmented, this temporary file can become 
unavailable.  This can effect performance, since Windows works best 
when it has allocated hard disk space to use at any time for swapping a 
file in or out of your computer's memory.  It is therefore best to set up a 
permanent swap file, and to make the size of the permanent swap file at 
least 6MB.  Look at the Help menu of the Windows Control Panel or in 
your Windows documentation for more information.
You may find that your system runs slower with a swap file if you're lucky 
enough to have more than 16MB of RAM.

* Defragment or optimize your hard disk by running a defragmentation 
program.  Some of the more popular of these are PC Tools, Norton 
Utilities and Mace Utilities.

* Add more RAM (memory) to your computer.  You can determine how 
much memory is available by starting MS-DOS, typing "msd" and 
pressing ENTER.  This starts a small program that will tell you how much 
memory you have.  You need at least four megabytes (sometimes listed 
as 4096 kilobytes or KB) of RAM to run "Hutchinson Multimedia 
Encyclopedia".  However, eight megabytes (8MB) of RAM  (or more !) is 
highly recommended for optimum performance of "Hutchinson Multimedia
Encyclopedia".  If your computer has 4MB of RAM, adding RAM is one of 
the best ways to improve performance.  Please see your computer dealer
for information on buying and installing RAM on your computer.

* For more details on improving performance consult your Windows manual.
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THE PICTURES DON'T LOOK VERY GOOD

Many video cards can operate in more than one display mode such as 16, 256 or 
32,768 colour display mode.  If your video card is capable of a display mode with more
than 16 colours, you can run Windows Setup (usually in the Main program group in 
Windows Program Manager) to check your current display settings, and to change the 
display mode to see "Hutchinson Multimedia Encyclopedia" with better image quality.  
"Hutchinson Multimedia Encyclopedia" will look best and perform better in a display 
mode that shows 256 colours. Displaying more colours will often slow the machine 
down; "Hutchinson Multimedia Encyclopedia" contains 256 colour pictures and 
TrueColour (24-bit) pictures.  Please check the manual that came with your video card 
or personal computer for information on how many colours your video card can display
(while maintaining at least a VGA resolution of 640 x 480 or higher) before attempting 
to change your display setting in Windows Setup.

TROUBLESHOOTING TIPS: VIDEO DISPLAY CARDS AND DISPLAY 
PROBLEMS
 
In some situations, "Hutchinson Multimedia Encyclopedia" may encounter video 
display problems when using high resolution video drivers from various video card 
manufacturers.  This problem can often be fixed by obtaining updated drivers from 
your video card manufacturer.  Make sure the video drivers you are using were 
designed to be compatible with Windows version 3.1.

An alternative to obtaining a new or updated display driver is to change your video 
mode to a standard video mode such as 640 x 480 resolution, with as many colours as
your video card can support at that resolution. To use "Hutchinson Multimedia 
Encyclopedia" while waiting for an updated video driver from your video card 
manufacturer, you can use the standard VGA driver that comes with Windows.  This 
display mode is only 16 colours and some images may not look as well as they would 
in 256 colours.  Also, image display takes slightly longer when running in 16 colour 
mode.  For instructions on installing that, please see Help within Windows Setup in the
Main program group in the Windows Program Manager.

COMMON SOLUTIONS TO MAKING SOUNDS PLAY

SOUND DOESN'T PLAY AT ALL

1. Check the volume.

2. If the volume is turned up and you still hear no sounds, something may be
wrong with your sound board installation.  Check to see that the sound
board software is installed correctly and reinstall it if necessary.

3. If  the software is  installed correctly  the sound board may need to  be
pressed more securely into its slot or have a jumper setting changed on
the sound board.

4. If you have both a sound board and special software that bypasses the
sound board to play sounds through the PC speaker we suggest  you
remove  or  disable  the  special  software  (the  PC  speaker  driver).
"Hutchinson  Multimedia  Encyclopedia"  requires  an  MPC-compatible
sound board to be installed and is  not  meant to run with just  the PC
internal speaker or any combination of that speaker and special software.
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SOUND PLAYS BUT IS DISTORTED OR "FUZZY"

Sound distortion is often caused by sending a higher volume or amplitude of sound to 
the speakers than they are able to handle, or by turning the volume control on your 
sound board too high (distortion from the amplifier on the sound board).  Sometimes 
speakers that are not of high quality will distort at a lower volume than better speakers 
will (compare a clock radio speaker to a big stereo system; the stereo speakers can 
play much louder with no distortion).  For example, if the volume for your sound board 
or "WAVE file output" is set to near its maximum it will produce distortion just like a 
radio that is turned up too loud.  To learn how to change your sound board settings 
check the manuals that came with your sound board.  This is normally done with either
a volume dial on the back of your sound board (in the rear of your computer where the 
speakers plug in) or with a program that is often called a "mixer", that is usually 
installed in the Windows Control Panel of the Main program group.  Some sound 
boards use both types of controls and they must both be adjusted.

SOUNDS ARE CUT OFF

Your computer can only play one sound at a time therefore other sound producing 
programs could interrupt the sounds in "Hutchinson Multimedia Encyclopedia".  Some 
sound producing programs may take over the audio capability and prevent other 
Windows programs from being able to make sounds.  If you suspect you have such a 
program do not run it at the same time as "Hutchinson Multimedia Encyclopedia".

MAKING SURE THE SOUND CARD IS INSTALLED PROPERLY

1. Verify Port and IRQ settings by looking at the sound card and comparing
the way it is set up to the way that the sound board software thinks it is
set up.  The sound board manual should explain how to read the sound
board.

2. Make sure the sound card does not conflict with other hardware.  This is
done by comparing the setup of the sound board with the setups of other
cards in your computer.  It is important that no two cards try to use the
same port or IRQ.  This is a common source of problems when you are
getting no sound at all.

CD-ROM Extension (MSCDEX) Explanations

The combination of the CD-ROM Extensions (MSCDEX) and a CD-ROM device driver
allow you to connect a CD-ROM drive to a DOS-based personal computer (computers
that run Windows are considered DOS-based also).  The MSCDEX command is run
from  the  AUTOEXEC.BAT  file  and  the  CD-ROM  device  driver  is  loaded  in  the
CONFIG.SYS file.  The CONFIG.SYS must contain the same name (for example, CD-
ROM1) as the one used with the /D: parameter on the MSCDEX line.  A text editor or
word processor can be used to edit these files if the settings are incorrect.  Be sure to
save the files as Text Only.

Example for CONFIG.SYS file:

DEVICE=CD-ROM.SYS /D:CD-ROM1

Example for AUTOEXEC.BAT file:

MSCDEX /D:CD-ROM1
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Command-Line Switches For MSCDEX.EXE

Outlined below are the various parameters available for the CD-ROM Extensions and
their usage.

Required Parameter

/D:[name]

Names the CD-ROM drive and corresponds with /D:[name] on the device
driver line in the CONFIG.SYS file.

Optional Parameters

/M:[value]

Sets  aside  extra  memory  for  reading  data  from  the  CD-ROM.   This
statement is similar to the DOS BUFFERS statement.

/L:[drive]

[drive] determines what logical drive letter to use for the CD-ROM.

/E

Tells MSCDEX to use expanded memory if available.  MSCDEX uses LIM
3.2 or later with page frame address at D000.

/S
Instructs MSCDEX to patch DOS to allow sharing of CD-ROM drives on
MS-NET compatible servers.

/V
Provides memory usage statistics, i.e., memory used by buffers, resident
data, and resident code.

/K
Tells MSCDEX to use Kanji (Japanese) file structures, if present, rather
than the default alphanumeric file structures.

Here are some examples:

1.  This example installs the CD-ROM Extensions and the following options:

MSCDEX /D:CDROM1 /M:12 /L:G
* Names the drive CD-ROM1
* Allocates twelve CD-ROM Buffers
* Makes drive G the CD-ROM drive

2.  This example installs the CD-ROM Extensions and the following options:

MSCDEX /D:CDROM1 /M:12 /L:G /E /S /V
* Names the drive CD-ROM1.
* Allocates twelve CD-ROM Buffers.
* Assigns the CD-ROM drive to Drive G.
* Uses expanded memory.
* Can be shared over an MS-NET network.
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* Displays memory usage statistics.

CD-ROM EXTENSIONS (MSCDEX.EXE) ERROR MESSAGES

CD-ROM extensions to MS-DOS (MSCDEX.EXE) along with the device driver for your
CD-ROM drive form the software components of the CD-ROM subsystem.  They are
not available from Microsoft.  Contact your CD-ROM drive manufacturer if you need to
update either MSCDEX or your CD-ROM device drivers.

The information below is an explanation of error messages you could see if the MS-
DOS CD-ROM extensions are not working properly.  These error messages generally
occur before your programs start and come up on the screen.

Critical Errors:

* CDR101 Read Failed

This means an error was reported by the device driver.  The most likely
cause is an open drive door, or the hardware dependent device driver
needs to be updated.  If this error occurs when you are installing your CD-
ROM drive it may indicate an improper installation of the CD-ROM drives
controller  card  and/or  software  device  driver.   Contact  your  CD-ROM
drive manufacturer for an update.

* CDR102 EMS memory no longer valid

The EMS memory possibly is corrupt.  You need to reboot the system.  If
this continues to occur after rebooting there may be a conflict between
the EMS memory being used by MSCDEX and something else on your
computer.  Try removing other items which may be using EMS memory.

* CDR103 Disc in drive is not High Sierra

All CD-ROM discs on a DOS or Windows-based system need to be in
High Sierra or ISO 9660 format.  If you attempt to read an audio disc or a
disc configured for an Apple Macintosh you will see this message.  It may
also indicate a need to update the device driver.  A quick test to find out if
the problem is with the disc or the device driver is to insert another CD-
ROM disc into the drive and see if it  can be used.  If the second disc
works the first disc may be damaged.

Initialization Errors:

* Incorrect DOS version

MSCDEX does not work with DOS Versions 1.x or 2.x.  MSCDEX.EXE
versions  below  2.21  requires  loading  the  SETVER.EXE  utility  in  the
CONFIG.SYS for proper functionality with MS-DOS version 5.0 or above.
This driver is required because MSCDEX.EXE version 2.20 checks the
version of DOS prior to loading.  It  will  display Incorrect DOS Version
SETVER.EXE is not loaded.

To  work  around  this,  load  the  SETVER.EXE  utility  by  editing  the
CONFIG.SYS file and adding the following line:

DEVICE=C:\DOS\SETVER.EXE
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Note: IBM PC-DOS does not have MSCDEX.EXE in the setver table.  It
must be added manually by typing  setver mscdex.exe 4.01 at the
prompt.

Ideally, MSCDEX version 2.21 or above should be used with MS-DOS
version 5.0  and MSCDEX version 2.22 should  be used with  MS-DOS
version 6.0.  

* MSCDEX already started

MSCDEX  is  already  installed.   You  can  have  only  one  instance  of
MSCDEX running at a time.

* Device driver not found: 'DEVNAME'

The device driver  name given on MSCDEX's command line /D:[name]
was not  found.  Make sure the directory path and name are correctly
spelled and the device driver is correctly installed.  Also, make sure the
device driver is loading without displaying any errors.

* No valid CD-ROM device drivers selected

MSCDEX  will  not  install  if  there  is  no  /D:[name]  specified  with  the
MSCDEX command or if the one given is not found.

* Not enough drive letters available

You need to increase the number of drive letters available by using the
LASTDRIVE command in the CONFIG.SYS file.

LASTDRIVE=Z

* Expanded memory allocation error

An  error  was  reported  by  the  Expanded  Memory  Manager.   The
Expanded Memory  Manager  may  be  corrupt;  it  may  be  necessary  to
reboot to install MSCDEX.  If this continues to occur after rebooting there
may be a conflict between the EMS memory being used by MSCDEX and
something else on your computer.  Try removing other items which may
be using EMS memory.

* Illegal option "X''

An illegal command line option was specified.  If this happens the illegal
command will appear in quotes.

* Expanded memory not present or usable

This is a warning.  You cannot use Expanded Memory if it is not there.
MSCDEX will continue using normal memory.

* Not enough expanded memory, reducing number of buffers

This is only a warning.  You cannot ask for more buffers than will fit in
available memory.
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